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About the Uniscan A30 Scanner - Equiprment included:

Chapter 1

Please ensure all the following items are included before installing the
Uniscan A30 scanner.
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I. Uniscan A30 Scanner
2. Power cord

3. Quick guide

4. Installation CD



About the Uniscan A30 Scanner - Software Installation

Software Installation

The Uniscan A30 Utility provides a convenient interface for accessing
the advanced scanning functions. With the Uniscan A30 Utility, you
can quickly scan documents or images, make a quick copy of a
document and send it to the printer, scan an image and send it
directly fo your email client, scan text documents and edit them with
word processing software, or define a default application to send
your scanned document to for post processing.

CUSTOM E-MAIL Scan OCR COPY/PRINT

il :_E | @ | abc) Q
E it | Preferences Help |

The Uniscan A30 Utility interface emulates the control pad on the
scanner, and allows you fo control scanner functions from your PC:

00000

@B'-é

The Uniscan A30 Utility interface has five buttons: Scan, OCR, CUSTOM,
Copy/Print and E-mail. Pressing a button scans an itfem and sends it to
your printer or a specific application, such as your e-mail software.

Each button has a default application pre-selected for post
processing. When you install the scanner, the software checks your
computer for an application that is appropriate for each button (for
example, Microsoft Outlook for the E-mail button). If one is found, the
software assigns that application to the button.
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About the Uniscan A30 Scanner - Connecting to the Scanner

If you want to select another application or customize the scan
settings, you can create new configurations or edit existing ones. For
example, if you scan color photos for use on the Web, you can create
a configuration that works best when scanning pictures for use with
HTML.

This scanner uses the USB interface, which is only supported by
Microsoft Windows 98/Me, 2000 or XP.

Plug & Play devices are supported by the USB interface. To verify
whether your computer supports USB, first make sure there is a USB
port at the back of your PC (some computers have USB ports in other
locations, such as on the monitor or keyboard).

If your computer does not have any USB ports, you may need to install
a USB interface card (check your computer User's Manual for USB
support information).

USB Port

AT




About the Uniscan A30 Scanner - Connecting to the Scanner

Starting the Uniscan A30 Utility

After installing the scanner software and drivers and rebooting, the
scanner icon 22 will be displayed in the Windows taskbar:

|<ﬂ,@% 5:26 PM

Double-clicking the icon opens the Uniscan A30 Utility:

Unizcan A30 I

il =] | ©) | abe] Q

E wit | | Freferences I Help |

Note: If you have not connected the scanner to the PC, the scanner
disconnected icon &2 will be displayed. You must establish a
connection before using the Uniscan A30 Utility.

Once you have connected the scanner via USB port, the Utility will

automatically connect to the scanner and display the following

message box:

o= Connecting Unizcan £30 .

If the connection fails, you will see the following message:

=2 [Uniscan &30 Connect FAILED ..

Please refer to Troubleshooting for more information.

Clicking a button opens the associated application. Click Help to
display online help for the Uniscan A30 Utility. Click Exit to send the
Utility back to the Windows Taskbar. Clicking Preferences enables you
to set preferences for each application.



About the Uniscan A30 Scanner - The Uniscan A30 Utility Interface

The Uniscan A30 Utility Interface

The following table describes the function of each button on the
Uniscan A30 Utility interface:

Scan Button: Click Q to scan documents and

images. The images are sent to Photo Suite SE for
post processing. You can change the default

post processing application by clicking
Preferences and selecting a different program
Copy/Print Button: Click @ to send a scanned

@ image or document directly o a printer or printer
- application.
OCR Button: Click to convert a scanned
item to black and white text for use with word

_— processing software.

T E-Mail Button: Click = to send a scanned
_.E image or document directly to an e-mail

program.
Custom Button: Click @ to send a scanned
@ | image or document directly to a pre-selected
application.
Freferences |
Preferences: Click i [to set preferences for each

button. You can add and choose settings for post processing
applications, set scanner status display options, and set
advanced properties such as image mode, color control and
resolution.

Exit: Click __®__|to send the Uniscan A30

E it
A Utility back to the Taskbar.
Hel Help: Click e 1o display the online help
: for the Uniscan A30 Utility.

The next chapter describes how to use each function in detail.



This chapter describes each function in detail.

Note: For information regarding the TWAIN Interface, refer to the
TWAIN Interface online help.

Use the Scan function to scan images or documents and send them
to the TWAIN Interface for image post processing. Follow these
instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan A30 Utility icon in the Windows taskbar.
The Uniscan A30 Utility will open.

|<E-@% 8:26 PM




Using the Uniscan A30 Utility - Scan Function

3. Click the Scan button on the Uniscan A30 Utility. The TWAIN
Interface will open.

il == | © | abe

E xit | Preferences | Help

4. Inthe TWAIN Interface, make any adjustments to the General
Settings and Image Adjust before clicking Scan.

If sending the scanned image to another application after scanning, you
must wait at least ten seconds for the post-processing application to
load.

Note: For information on setfting the TWAIN interface opfions, refer to
the TWAIN interface online help.

[ nance |
1=

B s B (3

B Feflective

BN Color 24bit

%]  200dpi
B NoDesoeen

Custam

I Auto Adiust

Note: You can setf the post processing application that the TWAIN
Interface sends the image to. Please refer to the Preferences
section for more information about settings.



Using the Uniscan A30 Utility - Copy/Print Function

Copy/Print Function

Use the Copy/Print function to scan images or documents and send
them to the printer.

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. In Windows, double-click the Uniscan A30 Utility icon in the
Windows taskbar. The Uniscan A30 Utility will open.

|<E-@% 5126 PM

3. Click the Copy/Print button on the Uniscan A30 Utility interface.

E xit | Preferences | Help |

:_E | @ | ahc)




Using the Uniscan A30 Utility - Copy/Print Function

4. After the image is scanned, the Print dialog box opens. Note that
you must wait at least ten seconds for the Print dialog box to load.

Note: By default, the scanned image is sent directly to the selected
printer without opening the TWAIN Interface.

Print |
Frinter - WM TASHP Lazer)et 4100 PCL B

Copies: I_-|ﬁ

— Picture Position

) Flictureim the Eenter
] |

€ Picture Pl Page

{7 Piciue fds streteh Cancel |

% Pictureiin the Wppen Left

5. Click Printer to select a printer. A new Print dialog box will open.
Select a printer icon from the menu. Click Print to print out the
scanned image, or click Cancel to return to the Scanner Ufility
Print dialog box.



Using the Uniscan A30 Utility - Copy/Print Function

1'*' Print 7 x|
General |F'age Setupl Compreszion Dptionsl Faont Embeddingl About I
— Select Printer
. - = = =
Add Printer Acrobat Acrobat HF Laserlet  HP-5100 on
Distiller FOFwiiter  4100PCLG ... htas-ats
Status: Ready
Location:
_ Find Frinter... |
Comment;
—Page Range

& A Mumber of copies: |1 3:

) Seletion ) Current Page

) Pages: 7 Callate @

Prirt I Cancel |

6. Click OK. The document is then sent to your printer.

$emEl=(E) sszem
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Using the Uniscan A30 Utility - Custom Function

Use the Custom function to scan images and documents and send
them to a user-defined application for post processing.

Note: Before you can use this function you must assign a default
application for post processing.

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan A30 Utility icon in the Windows taskbar.
The Uniscan A30 Utility will open.

|<ﬂ-@% 5:26 PM

3. Click the Custom button on the Uniscan A30 Utility. The TWAIN
Interface will open.

E xit | Preferences | Help |
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Using the Uniscan A30 Utility - Custom Function

4. Inthe TWAIN Interface, make any adjustments to the General
Settings and Image Adjust. Then click Scan.

After the image is scanned, it is sent to the assigned application for post
processing.

Note: For information on sefting TWAIN interface options, please refer
fo the TWAIN interface online help.

Reflective

Color 24 bit

200dpi

No Descreen

Custom

ELLLL L
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Using the Uniscan A30 Utility - OCR Function

Use the OCR function to scan images or documents and send them to
your default word processing application. Follow these instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan A30 Utility icon in the Windows taskbar.
The Uniscan A30 Utility will open.

|<E-@% 8:26 PM

3. Click the OCR button in the Uniscan A30 Utility. The TWAIN
Interface will open.

B e\ =&

E wit | Freferences | Help |
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Using the Uniscan A30 Utility - OCR Function

4. Inthe TWAIN Interface, make any adjustments to the General
Settings and Image Adjust, and then click Scan.

After the image is scanned, you must wait at least ten seconds for the
word processing application to load.

Note: Before you can use this function, you must assign a default
application for post processing. Refer to Preferences for more
information.

o S QL G | | Advance |
| B4 x4,

Reflective

Color 24 bit

200dpi

No Descreen

Custom

ELLLL L
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Using the Uniscan A30 Utility - E-nail Function

Use the E-mail function to scan images and documents and send
them to your e-mail program. Follow these instructions:

1. Place the item face down on the scanner, with the corner of the
paper next to the arrow, as shown:

2. Double-click the Uniscan A30 Utility icon in the Windows taskbar.
The Uniscan A30 Utility will open.

|<E-@% 8:26 PM

3. Click the E-mail bufton on the Uniscan A30 Utility. The image will
then be scanned.

@ | ahc,)

E wit | Freferences | Help |

4. After the image is scanned, it is sent to your default e-mail
program and attached to a blank e-mail, ready to be addressed
and sent. Note that you must wait atf least ten seconds for the e-
mail program to load.

15



Using the Uniscan A30 Utility - E-4mail Function

gt Attached Files

J File Edit Wiew Insert Format Tools Message Help

=101 %]

K
Wndo

E‘&i%% g, "
[

Send Ut Copy  Paske Check  Speling
Bce |

To:
Subject: I.ﬂ.l:l:ached Files

Attach: @Pmnnnnn.JPG {2.33 MB);

FlEE Ehi o uvil=s"
=
[
A
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Using the Uniscan A30 Utility - Preferences

The Preferences dialog box enables you to configure the settings for
each button and assign applications for post processing. Double-click
the scannericon 22 in the Windows taskbar to open the Uniscan A30
Utility:

il == | ©) | abc]

Help

L

E it | | Preferences

Click Preferences to open the Uniscan A30 Utility Preferences dialog
box:
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Using the Uniscan A30 Utility - Function Settings

Function Settings

This section explains how fo use the options in the Uniscan A30 Utility
Preferences Function Settings tab.

Uniscan A30 Utility preferences B4
Function | Preferences |

@ Select Menu:
IE Scan j

ﬁ Select Default Application:

K.odaklmg

Add Application Remove Application |
Adv, properties | Fezet to default |
[u]4 | Cancel | Help |
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Using the Uniscan A30 Utility - Select Menu

The Select Menu enables you to choose which button you want to
configure and set preferences for. Choose a button from the drop-

down menu:

Uniscan A30 Utility preferences B4

Function | Preferences I

@ Select Menu:

& Scan

@ Copy/Frint
Oer

=¥ cand

= Email

@ Custam

Add Application

Remove Application |

Adv, properties

| Rezet to default |

[u]4 | Cancel | Help |

After selecting a button, you can add or remove an application to be
associated with it, set advanced properties, or reset the button to the

default values.

Add Application

Use Add Application to associate an application to a button for post
processing scanned images or documents.

1. Select a button from the drop down list.

19



Using the Uniscan A30 Utility - Select Menu

Unizcan A30 Utility preferences

2. The button's default application list is displayed:

20



Using the Uniscan A30 Utility - Select Menu

Unizcan A30 Utility preferences | X|

Function | Preferences I

@ Select benu:
IE Scan j

ﬁ Select Default Application:

F.odaklimg

Add Application Remowe Application
Adv, properties Fiezet to default
OF, Cancel Help

3. Click Add Application. The Open applicafion dialog box is
displayed:

Laoak in: Ia Phatoshop 7.0 j = £ Ef-
Help [ Samples
Helpers E:’ImageFIeady.e:-te
Legal @Phutoshop.exe
Plug-lnz
Prezets
Required
File name: |Ph0tosh0p.EHe
Files of type: I".exe LI

21



Using the Uniscan A30 Utility - Select Menu

4. Browse to the location of the application that you want
associated with the button. Click Open to add the application to
the default application list:

Uniscan A30 Utility preferences x|

Function | Preferences I

@ Select Merw;
I‘E’ Scan j

:5 Select Default Applicatian:

Add Application | Remowe Application |
Ay, properties g Resat to default |
ak | Cancel | Help |

5. Select the application and click Adv. Properties. The Properties
dialog box is displayed:

22



Using the Uniscan A30 Utility - Select Menu

Properties x|

Calar Contral

— Image Mode

" Calor Image Erightriess I 0=
" Gray Image Contrast I Uﬁ
B/ Image Gamma I ==!

— Resalution

¥ Dizable Twain, using autocrop

ok I Cancel

The Properties dialog box enables you fo set the following item:s:

» Image Mode: select color, gray, or black & white (B/W) for output
image mode.

»  Color Control: enter the brightness, confrast, and gamma in the
boxes.

»  Resolution: select the output resolution from the drop-down menu.
You can select a resolution from 75 to 600 dpi.

Check the box next to Disable TWAIN, using autocrop, fo have
images scanned directly to the application without being opened in
the TWAIN dialog first. The image is automatically cropped before
opening in the application.

Click OK to save your changes and refurn to the Uniscan A30 Utility
Preferences dialog box or click Cancel to exit without saving
changes.

To remove an applicafion from the button’s default application list,
select the applicafion and click Remove Application. To refurn the
button’s application list to the default settings, select the application
and click Reset to default.

23



Using the Uniscan A30 Utility - Preference Settings

Preference Settings

In the Uniscan A30 Utility Preferences dialog box, click the Preferences
tab to open the following screen:

Uniscan A30 Utility preferences B4

— Dizplay zcanner statuz

[ Display Uniscan A20 status message

¥ Show scan progress dislog when Twain is disabled

— Temp faolder

C:WIRMNTAT wain_32%A4305T emp Falder |

Clean temp folder files I

— Smart Scan status
¥ Show all applications for each scanner button

¥ Holding scanner button activates Preferences window

[u]4 I Cancel Help

Display Scanner Status

Display Uniscan A30 status message: click this box to display a
Scanner Activated message at the top of the Windows desktop:

Show scan progress dialog when TWAIN is disabled: click this box to
display a scan progress window when the TWAIN box is disabled.

24



Using the Uniscan A30 Utility - Preference Settings

| Cancel l

Temp Folder

This setting enables you to select the folder where image files are
stored. Set this folder on a drive with sufficient disk space for large
image files. Click Clean temp folder files to delete the files in the temp
folder.

Smart Scan Status

Show all applications for each scanner button: uncheck this box fo
display only the applications that were assigned to the bufton when
you installed the software.

Holding scanner button activates Preferences window: if this box is
checked, pressing and holding any of the buttons on the scanner will
open the Uniscan A30 Utility Preference dialog box.

25



Scanning with TWAIN compliant applications - How to Initieste the
TWAIN interface

In addition to the included Presto! PageManager scanning software,
the scanner can also be used with any other application that
accepts scans via a standard link called TWAIN. Most major scanning
and image software programs operate using the TWAIN interface,
including MGI PhotoSuite, CorelDraw, IphotoPlus, Painter,
PhotoDeluxe, Photolmpact, PhotoShop, TextBridge, and many more.
This chapter discusses how to use the TWAIN interface in detail.

How to Initiate the TWAIN interface
After installing the scanner and associated software, you should be
able to find the scanner commands, as follows:

1. From within the TWAIN compliant application, choose Select
Source in the File menu fo show the Select Source dialog box.
Select "Uniscan A30". Then click Select to close the dialog box.

Select Source EE3 |
— WAl sources

k. I Cancel
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Scanning with TWAIN compliant applications - How to Initiate the TWWAI

open:

T N = | 2 W G 2

Chif 4%,

N interface

Choose Acquire in the File menu, and the TWAIN window will

Reflective

Color 24 bit

200dpi

Mo Descreen

Custom
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Scanning with TWAIN compliant applications - Scanning settings

Scanninu settings
Zoom
Drag MultiJob Setup Toggle Advanced/Primary Exit TWAIN
Crop Mode
Help

Ruler button

3 @idsxs

Reflective
Configuration
area

Color 2:
200dpi
Preview window Na Descreen

Custom

[ Auto Adjust

N
N

Message bar Crop
box

Click to initiate preview Click to scan
Preview Window

After clicking the preview button, this window shows the document or
photo on the scanner glass. You can then view the effects made by
changes to the scan settings and define an area to scan: simply drag
your mouse to outline the area. You can adjust this area'’s size by
dragging its handles, or its position by clicking on it and dragging. At
the top left of the window is a ruler type button; click this to toggle the
ruler units between inches and cm.

Ruler Button

Clicking on the icon in the top left corner of the preview window
allows you o toggle the ruler's measurement units from inches to
centimeters.

28



Scanning with TVWAIN compliant applications - Scanning settings

Crop

Selects the cropping fool. With this tool selected, click and drag with
the left mouse button in the preview window to define the area to be
scanned.

Drag

Selects the Drag fool. With this ool selected, click and drag with the
left mouse button to move the selection.

Zoom

Zoom in or out by clicking in the preview window.

Multilob

The Multijob function allows segmenting a scan image info mulfiple
sections, to output to multiple image files. This way, you can scan
different sections of the original image into several different output
files. For example, using Multijob, you can create a scan of the entire
picture and also each of the four quadrants of the image with one
pass of the scanner. The maximum number of mutlijobs is six.

setup

Opens the Setup dialog box. From this dialog box, you can configure
preset scanning icons for one-click scanning from the Primary mode.

Help
Opens TWAIN online help.
Message har

The message bar displays the predicted size of your scan, the current
units and the amount of free space on your hard disk. The predicted
size changes if you change the scan area size, scan mode and/or
resolution. If the image size exceeds the amount of free space, you
will not be able to complete the scan. In this case, you can lower the
scan mode, resolution or scan areq, or create more space on your
hard disk.

Toggle Advanced/Primary Mode

Click the Advance/Primary button to switch between Advanced and
Primary modes.

Primary Mode

In Primary mode, you can click one of the five preset icons to
scan depending on your desired type of output.

The five icons are: Scan Photograph, Scan Magazine, Scan

29



Scanning with TWAIN compliant applications - Scanning settings

30

Data for OCR , Scan Photo for Web, and Custom.

Advanced Mode

In Advanced mode, you can set specific settings for this

particular scanning instance. See Configuration Area, below,
for details.



Configuration area - General Settings

General Settings
-

Reflective
Calor 24 bit
200dpi

Mo Descreen

Custom

[ Auto Adjust

' ave | Load | [ Defauft

General Settings provides the following general configuration options:
Color Mode

Color Mode determines the amount of color information collected
from your original. Choose this opfion based on whether the original is
color or black & white, and on the purpose of your scanned image
(i.e., color display, black & white printing, OCR, etc.). Your choice also
influences file size; frue-color creates the largest files, while grayscale
creates smaller files and black & white creates the smallest. When you
change this option, notice the projected file size in the message bar:
frue-color images are three times larger than grayscale and twenty-
four times larger than black & white!

Color 48-Bit

Your scanner is capable of scanning images using 48-bit color depth.
This provides a more dynamic color and tonal range, giving your
scanned images a smoother and more colorful appearance.

The 48-bit color mode is disabled by default because currently only a
few application programs (such as Adobe PhotoShop) can accept
48-bit image data. When disabled, your images will be scanned in 24-
bit color mode. To scan images in 48-bit color, simply enable 48-bit
Color Mode in the Color Mode menu.
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Configuration area - General Settings

Color 24-Bit

This color mode collects a large amount of color information from the
original, up to around 16.7 million colors! Choose this option for a color
original that you want to display, print or edit in color.

Grey 16-Bit and Grey 8-Bit
Use either of these modes for black & white photos or for scanning

color material fo print on a black & white printer. Choose 8-Bit for
lower quality and smaller file size black & white images.

B& W

Use this mode fo scan text or line drawings - a picture or text
containing black lines only, with no colors or shades of gray.

Resolution

Resolution determines the amount of detail collected from an original.
The higher the resolution, the greater the detail. Select a value based
on the purpose of your scan. In general, we recommend you keep
the resolution as low as possible, because the higher the resolution,
the slower your scan and the larger the resulting file size. Furthermore,
a lower resolution (100-200dpi) when using True Color or Greyscale
can capfure more color and detail than most printers or monitors can
show. When you adjust the resolution, keep an eye on the projected
file size in the message bar. The following are suggested settings for
various scan file types:

Document Type Resolution
Text (printed) 300
Text (fax) 200
Text for OCR 300

Black & White or greyscale image 150
Color photo orimage 150

100 dpi

For images to display on screen at about the same size as the originall
in a presentation or on your web page. Also use this for larger images
that you will reduce in size to include in a report or presentation and
print out on a normal color or black & white printer (with a print
resolution of 300~360dpi).

200 dpi

For small images to display at a larger size on screen, or for any image
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Configuration area - General Settings

to be printed out at original size on a color or black & white printer (up
to 720dpi print resolution). Also use 200dpi (with black & white scan
mode) for clear OCR text (larger than 10pt); for smaller text, use
300dpi.

300 dpi

When quadlity is critical and a lower resolution is inadequate, choose
300dpi for any size image and for any use (fo determine if the
resolution is too low, look for squares in the image; see below). Also
use 300dpi (with black & white scan mode) for opfimum OCR results.
Over 300 dpi

Unless you have a specific reason for selecting a higher resolution, we
suggest you do not, as the resulting file size may be very large and
take up alot of your hard disk space. For example, a 3" x 5"

photograph scanned at 2400dpi, true-color will result in a file over
240MB in size.

i

200dpi 200dpi 200dpi 200dpi
(enlarged 2x) (enlarged 3x) (enlarged 4x) (enlarged 8x)

300dpi 300dpi 300dpi 300dpi
(enlarged 2x) (enlarged 3x) (enlarged 4x) (enlarged 8x)
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Configuration area - General Settings

Note: When scanning an image that will result in a file size larger than
25MB, a warning screen will appear giving you the option to
cancel.

Descreen

Descreen is used to reduce the effects of Moiré patterns. Although
not always obvious, Moiré patterns interfere with the quality of your
scanned image. Depending on their severity, they can appear as
waves or patterns superimposed over your image, or simply make the
image fuzzier. Moiré is a form of interference caused by the imperfect
alignment between pixels sent from the video card and the screen.
They appear in all color scan displays, and more often affect scans of
printed images than text, as well as scans at higher resolutions as
compared fo those of lower resolutions.

Moiré patterns are an inevitable result of scanning, and will not be
completely eliminated untfil significant improvements in monitor
technology can be made. If your scanned image is overlaid with a
ripple, wave, dot or other odd pattern, select Descreen and scan
again to remove this phenomenon and produce a cleaner image.

The scanner scanning in half fone pixels causes moiré, which the
screen is not able to display well. Descreen operates by replacing
half tone pixels with full fone pixels. Use higher levels of Moiré
Reduction for objects printed in Matt finish or on plain paper, while
lower levels can be used for originals such as gloss finish photographs.
A side effect of using the Descreen feature is a loss in quality of the
scanned image; try different settings until you find a setting that gives
the best compromise between quality and clarity.

Scan Size

Choose a Scan Size depending on the size of paper you wish to
output to (if output is to be printed). You can also adjust scan size by
cropping the image in the preview window, which will sef scan size to
Custom. You can move the area by dragging the box.

Auto Adjust

The auto adjust function is disabled by default. Select this option to let
the scanner automatically determine the size of the item being
scanned. When Auto Adjust is selected, the scanner makes two
passes. The first pass detects the item's size and the second pass scans
the item. To enable Auto Adjust, simply check the Auto Adjust box in
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the general settings window.

Image Adjust is used to make specific alterations to the quality and
coloration of the output image. When you are satisfied with the
adjustments you have made, you can save the configuration for later
use by clicking Save and selecting a file name and directory. Image
Adjust contains 4 option screens: General Adjust, Curves, Level and
HSB.

General Adjust

General Adjust allows you to adjust the Brightness, Contrast, Gamma
and Sharpness of the output image.
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Brightness

Brightness is a measure, ranging from —100 fo 100, of the relative
lightness or darkness of the image. Increasing the brightness will
bleach the scanning image, while decreasing it will result in a darker
finalimage. Move the slider to adjust the brightness of the overall
image or the selected color.

Contrast

The higher the Conftrast, the clearer the image, while lower Conftrast
results in blurry images. Increasing the Conftrast decreases the mid-
range hues, and increases the high and low hues. Generally, adjusting
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Confrast is used to eliminate spots and shadows from scanned black
& white or greyscale images, or to "clean" color images. Move the
slider to adjust the Confrast of the overallimage or the selected color.
This function is not suitable for line drawings or other pure black &
white images.

Gamma

Moving the Gamma slider will affect the colors in your image as seen
on the monitor. Although the default Gamma setting is ideal for most
scans, the computer does not always receive the precise color
information from the scanning hardware, and some distortion in color
may occur. Through altering the gamma of either the overallimage
or the selected color, you can achieve the exact coloration you
desire.

Sharpness
Move the slider to make the image sharper or fuzzier.
Curves

Select Curves to display the red, green, or blue color curve. The mixed
color will be displayed in black.
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Note: changing the color curve will affect the results of all scanner
output.

Level

Level displays a histogram of the distribution of red, green, blue,
grayscale, hue, saturation, and/or lightness values in an image. The
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horizontal axis represents the lightness values of the image from black
fo white (0 to 255). The vertical axis indicates the number of pixels at

each value. At a lightness level where there are many pixels of one of
the values, the corresponding line spikes; where there are few pixels, it
appears close to the horizontal axis. In dark images, most of the pixels

are grouped at the left side. If an image is too light, the pixels are

grouped at the right.
-
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Saturation is the intensity or purity of the colors displayed in the image.

37



Configuration area - Tips for correcting scanned images

The intensity of the color refers to the color's distance from the shade
of gray; a value of —100 represents gray, while a value of 100
represents the most intfense color.

Hue indicates a color's position on the standard color wheel. At a
value of 0, the colors stay true to the original image. Changing hue
rotates the color's position by the appropriate number of degrees
along the color wheel. For example, selecting a hue value of -30
rotates the color's position 30 degrees, while a hue value of 30
represents a clockwise rotation of 30 degrees. Obviously, the greatest
hue values are —180 and 180, which changes all the image's colors to
the exact opposite colors according to the color wheel.

Brightness is a measure, ranging from —100 to 100, of the relative
lightness or darkness of the image. Increasing the brightness will
bleach the scanning image, while decreasing it will result in a darker
finalimage. Move the slider to adjust the brightness of the overall
image or the selected color.

Tips for correcting scanned images

The above options are for advanced users and users already familiar
with image editing tools. We strongly recommend that beginners do
not use these tools until they have become familiar with the scanner
and the technical terminology related to image creation. Many
image editing software applications also include these functions. If
you must adjust image color levels, please choose the appropriate
options before you begin adjusting. Below are a few practical tips for
your reference.

Also known as tone correction commands, these settings adjust
images as they are scanned. For example, you may have a photo
that is over-exposed (too light); you can thus decrease the brightness
or color correction to darken the photo. Contrast makes the
difference between dark and light areas more or less obvious.
Increasing it increases the difference, while decreasing if reduces the
difference. Try small changes at first and view the effect.
Experimentation is the best route to good results. However, for most
photos and documents, you will not need to adjust these values.

The color correction control also allows you to adjust the gamma. If
you have an "“off-color” original, for example one in which skin tones
are a little green, try reducing green gamma and/or increasing red
gamma. Gamma may be adjusted either by increasing/reducing the
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gamma of the color, or by reducing/increasing its complementary
colors.

After previewing your scan, changes made to these setftings are
reflected in the preview window. Making changes in this way allows
you to experiment without having to scan again to check the results
every time.

Hint: look at the gray strip on the right
'ﬂ'rmﬁﬂim

Bright -25

e ——
i

Contrast -25 Contrast +25
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Scanning night shots*

If you have particularly dark photos (that are correctly exposed) try
increasing the gamma a little (maybe up o 1.4) to bring out details in
the shadowed areas without affecting the overall tonal range in the
image.

Scanning snow shots*

For very light photos, for example from a skiing frip in bright sunlight,
reduce the gamma (maybe down to 0.8) to bring out details in the
bright areas. This again does not affect the overall tonal range in the
image.

» If you use brightness or contrast in the above two cases, you
actually reduce the amount of information collected from the
original, while gamma collects more information in the darker or
lighter areas, and less in the opposite type of area.

Scanning text for OCR

If your OCR result is not satisfactory, it may be because the original is

unclear. First, adjust the brightness. Try =10 for bolder text, for lighter,

fry +10. With this you can increase the contrast slightly for bolder text
or decrease the contrast for lighter text.

Scanning line art drawings

If parts of lines fade out after scanning, you can reduce the brightness
and/or decrease the contrast in much the same way as for scanning
text. Similarly, if you find that scanned lines appear bolder (fatter),
reduce the brightness and/or increase the contrast.
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Troubleshooting

This section provides information on maintaining the scanner and
answers questions to help you solve problems you might encounter
when using it. If you continue to experience problems, or if the
problem is not covered in this guide, please contact your local dealer.

Scanner does not respond.

»  Make sure all connections are secure and correct.

» Restart the computer and try again.

» Reinstall the software, restart your computer and then try again.
>

Check that the Universal Serial Bus of your computer is Enabled.
This setting (Universal Serial Bus Controller) can be found under
the System option in your Control Panel in the Device Manager (if
in doubft, check Windows Help).

Setup wizard does not autostart.
»  Check your computer system to see if Autostart is available.

» Under Windows, check if your CD-ROM is set to Auto Insert
Notification. This setting can be found under the System option in
your Control Panel in the properties of your particular CD-ROM
model (if in doubt, check Windows Help).

Cannot find program icons after restarting the computer.

» If program icons do not appear in the Start menu under Programs,
fry reinstalling.

Setup wizard crashes during installation.
> Reinstall the software.

The scanner's scanning lamp does not light up.

>  Make sure the TWAIN window appears on screen. If not, reselect
the TWAIN source and activate the TWAIN interface again.

>  Make sure all connections are secure and correct.
Scanner scans very siowly.

» Make sure the resolution of the scanner is not set too high
(preferably 300 dpi or lower).
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» Check your connections (see Problems with connections above).

Error: Scanner not found,
Displayed if there is a problem communicating with the scanner. This
may be caused by a power outage, misconnection or an installation
problem. First check your connections and check that your wall
socket and power switches are all furned on. Next check the
following:
(1) USB sefting is enabled. (2) Power adapter is plugged into the
scanner connector. (3) USB cable is properly connected from the
scanner to your PC.
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Problems in TWAIN

The TWAIN window does not appear after choosing Acquire.
> Make sure all connections are secure and correct.

» Check that the scanner is selected in the Select Source dialog
box.

»  Reinstall the software.
» Check your connections (see Problems with connections above).
Unable to scan o application software.

» Check that the scanner is selected in the Select Source dialog
box.

> Make sure all connections are secure and correct.

» Close all open programs and Windows, restart your computer
and try again.

The scanned image is too light or too dark.
» Checkif the Scan Window is clean.
»  Adjust the brightness or color gamma settings and try again.

Moiré patterns appear on the scanned image.

» The original image is commercially printed. Try reducing the
resolution by a small amount, for example from 200 dpi to 190 dpi;
keep reducing unfil the patterns disappear. Or you may check
Descreen under the Advanced tab in the TWAIN interface.

Transitions in color are very abrupt (after scanning in true color

modeJ.

» This is normal if you are using a display mode that can only
display 256 or 16 colors. Try using a high- or frue-color mode

instead. Refer to the Windows Manual and your display card
guide for more information.
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